K — 5 Instructional Technology Lessons

Compiled by Henry Anker, ITAF, Local District 3, LAUSD

Each grade level’s list of skills builds on those mastered in previous grades.

Here are some general guidelines when managing all levels of students in a Computer
Lab, or in a classroom using laptops from a mobile cart:

Provide expectations for academic goals and behavior before walking over to Lab. Ensure
students’ hands are clean. When arriving at Lab, students are to be lined up quietly. Have
students enter in groups, 5 or so at a time, depending on how workstations are arranged
(generally in rows). Remind students not to touch computers until instructed to do so. Once
all students are seated, with their hands in their laps, reinforce expectations for behavior, and
explain why these rules are important to follow. Explain that students are going to be using
activities in reading, writing, math, and other subjects during the year. Remind students that
you will need to have them stop working at times, either to learn something new, deal with a
problem that came up, to share a discovery, or to stop because it is time to go. The most
effective way to have students stop and give you their attention is the have students put their
hands on their head (model this, and repeat). You might want to remind students that an
earthquake (or drill), or fire (or drill) could occur while they are in the Lab using computers,
and explain (or demonstrate) how to respond appropriately in that instance. Most schools have
a standard method of stopping work when an announcement is made over the PA system,
which you may want to remind students of as well.

Note: The lessons described here are modeled using the Apple Macintosh OSX 10.4.x or
higher interface, though most lessons can be easily modified for use with PCs running
Windows.

For students using laptops, it is especially important for them to learn to use the trackpad using
only one hand (the student’s dominant hand), using only the thumb and index finger. Learning
to do this correctly from day one is akin, though not life threatening, to a teenager learning to
drive using the right foot to control both the gas pedal and brake. As adults, we know it is not
possible to drive well having one foot on the gas and the other on the brake.




Fourth Grade

W
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. Masters word processing (tools, pallets, shortcuts, spell-check, save, print)
. Writes multiple paragraphs

. Saves file to designated location or media independently; opens saved files

from location, navigating through windows or dialog boxes

Uses Excel Spreadsheets (Data Table, Sum, Average, Graphs)

Graphs own OCR fluency progress using Excel

Switches between active applications using System Tray, Dock, etc...

Uses the Internet competently, safely; evaluates/judges sites for legitimacy,

appropriateness

. Creates a webpage or other multimedia project with research acquired

through the Internet and other sources (books, interview)

. Creates a research bibliography of books and websites with clickable links in

Word or PowerPoint

10.Creates acrostic poem with formatted title and initial caps

11.Types 15-25 wpm with 85% + accuracy

12.Restarts computer and diagnoses basic problems

13.Serves as peer tutor to others to mastery of specific skill
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Grade 4 - Lessons 1 -3
Masters word processing (tools, pallets, shortcuts, spell-check, save, print);
writes multiple paragraphs; saves file to designated location or media
independently
Before beginning with this lesson, be sure to review all of the previous
lessons back to Kindergarten to ensure students have mastered the skills from the
previous grades. If a majority of students show a need for one or more of the
earlier lessons, please do those first.
1. With an edited draft of a grade level writing assignment or end-of-unit
OCR writing prompt, review the following before students begin to
type text (it may be necessary to lead students through these, with
their own text, to get document started):
a. viewing Formatting Palette
b. changing font size

using proper keyboarding hand position and posture

o o

type standard heading that includes name, teacher name, date

@

text alignment (centering title, left align text, tab indents)
f. carriage returns for paragraphs (return key = tab key)
At this point, allow students 10-15 minutes to type a portion of their work.
2. Lead students through the process of saving work to designated
location (folder on Desktop, on server, onto Flash Drive

At this point, allow students 10 more minutes to continue typing.

3. Using a student’s completed e Splingand Gremar Foglin U5
document for demonstration e e ks sy [

lakes, climatic regions)

purposes, project the work for all

Suggestions:

students to see and contribute

answers.

v Check grammar

4. Pull down the Tools menu to
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Spelling and Grammar... As the dialog box opens and identifies the
first ‘questionable’ word, discuss why it came up in the window, and
what the choices are in addressing each word that comes up.
(Questionable word means that the word identified is not known to

the computer’s dictionary, either as a word that was included by the
maker of the word processing program, or a new word added by a user
of the computer. Proper nouns, like names often come up, especially
names like Gonzalez, Kayla, or Chang. These words will often be
underlined in red in the document. Let students know that these are
not mistakes, but that the dictionary does not have them in it.)

. Once students show they understand the process of spell-checking,
they can do it on their own, or with a partner when their writing is
finished.

. Other refinements that can be made to the document are changing the
font, size, color, and style of the title only. A good method of
reinforcing this is to hold up an OCR student text
and show how titles are always presented in a
special way, whereas the body text is written in

Times or Arial in the color black.

. When all of the students have written and

checked a substantial amount of their work, lead students through the
saving process. Most students should have seen and followed these
steps a number of times in previous grades, though you will also have
students who are new to the school and may not have had the
experience. This brings up an axiom that you may already employ,
which is, assume nothing, and allow students to prove to you that they
can do something: walk in line politely, raise their hands, multiply to

12 mentally, etc...
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8. Have students pull down the

File menu to Save...

9. Have students click on the

word Desktop in the left

sidebar, and the folder name at C|&

the top of the window changes

to Desktop.

10.Have students scroll down to

the STUDENT WORK folder.

Change the file name in the
Save as: field, leaving the
suffix .doc. Finally, click on
the Save button (or teach

students to press the return
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key to complete the saving process.

11.Allow students to continue typing until time is up. Have students

press 38 -S, then #-Q to quit.
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Grade 4 - Lesson 4 (Part 1)

Uses Excel Spreadsheets (Data Table, Sum, Average, Graphs)

As an introduction to Excel™ , use this lesson as a practice tool to make a

basic bar chart. The lesson is located at this address:

http://www.pumaland.net/Staff Pages/Henry Anker/Lesson Plans/Excel Lesson Anker.swf

o000 http://www.pumaland.net/Staff_Pages/Henry Anker/Lesson_Plans/Excel_Lesson_Anker.swf
[«]>] @ nttp:/ fwww.pumaland net/Staft_Pages/Henry_Anker Lesson_Plans /Excel_Lesson_Anker swf ©|~(Qr Google 3
(N AllMyFaves LD3Sites= Netherlands~ Mockingbird Sitesv Civil Warv Mr. Anker Tests Henry Anker's Home Page ITD Self-Service TEACHERPLUSINFO LAUSD-Apple Store

http:/ | www.pumaland.net/ .

Makingla Chart using
MicroSoft Excelll™

Assembled by Henry Anker, ITAF, LD3

All images @MicroSoft Coroporation
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Grade 4 - Lesson 4 (Part 2)
Uses Excel Spreadsheets (Data Table, Sum, Average, Graphs)
As an opportunity to see the basic mathematical power of Excel, have

students complete the lesson at this address:

http://www.pumaland.net/Staff Pages/Henry Anker/Lesson Plans/Excel Lesson 2.swf

Using Excel to Find
the Sum, Average, and
Make a Graph

Lesson 2
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Grade 4 - Lesson 5

Graphs own OCR fluency progress using Excel

We know, from working with the Open Court™ Reading Program for many

years, that improving reading fluency has many positive implications for students,

most especially, improved reading comprehension. Getting students more

motivated to read and practice their fluency is the role of the teacher. One way

many teachers has raised student reading fluency is through tracking their

progress, and then providing positive reinforcement to help students further

improve their fluency. When students take responsibility for tracking their own

fluency growth through mathematic awareness and technology use, they likely will

do even better. That is the goal of this Excel lesson.

1. Have students open Excel. Post the
sample data on the projected computer
for students to copy. Tell students to
copy the data. The only difference would
be that students would type their own

fluency numerical data.

2. Have students select the data as it is

shown in the illustration to the right.
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(Chart Wizard - Step 1 of 4 = Chart Type

3. Use Insert=> Chart, or click on the Make

Chart button in the button bar. Choose Line LL t E
Chart, as shown. Click Next. | &
4] () (=Y ars)
4. Clle NEXt. 800 _;ﬂdl
=== |

5. Add the text in the fields as shown.

o (Cance) (<) @) (Finsn)

Chart Wizard - Step 4 of 4 - Chart Location

6. Click Finish.

O As new sheet: |Chartl

@ Asobjectin: [ Sheetl [

7. The chart appears over the spreadsheet.

oo o
B 3 g 0
&

8. If you would like the students to write
about their experience with fluency practice, have them follow this
procedure:

a. click on the chart to select it

b. pull down the Edit menu to Copy
c. open a new Word document

d. change the alignment to Center
e. pull down the Edit menu to Paste
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Grade 4 - Lesson 6
Switches between active applications using System Tray, Dock, etc...

As technology has advanced, the ability to multitask has increased
dramatically, both with equipment and the people who operate it. Young people
seem especially able to listen to music, talk on a cell phone, chat on the Internet
and work on homework simultaneously.

When personal computers were first developed, they could only perform one
task at a time. If the user wanted to do another task, the first task had to be quit
(or exited) before starting the other. Now computers can perform several, or even
a dozen, tasks at once. Often a computer user will have several of the following
running simultaneously:

Web Browser ~ Word Processor Music Email Spreadsheet
Photos Movies Mapping Presentation Painting

On a Mac running any version of OSX, you can switch between actively
running programs by doing one of the following:
a. clicking on a window to bring it to the front
b. clicking on the icon for an application in the Dock

c. holding down the
command key and tapping
the tab key repeatedly
until you are on the
application you want (left
thumb on the command
key, index finger pressing
tab key

d. pulling down the application menu (next to the apple menu) to

“Hide__ __”. The last application accessed will then come to the
front while the application you hid will metaphorically hide behind
the Desktop.

e. pulling down the Apple menu to Recent Items

To practice this skill, have students open several programs you want them to
work with, for example: Word, PowerPoint, and a Web Browser. Students can
perform copy/paste tasks (see 3™ Grade Lesson on this topic), switching between
active applications using these methods.

87




Grade 4 - Lesson 7
Uses the Internet competently, safely; evaluates/judges sites for

legitimacy, appropriateness

This is a difficult lesson to teach completely within the LAUSDnet, or other
school district Firewall, as inappropriate web sites are, for the most part, blocked
for students’ safety. Students at this age, however, must begin to understand that
there are ‘strangers’ out there on the Internet. Some are pedophiles pretending to
be children or teenagers trying to make personal contact with our children after
luring them in through on line conversations.

These are very dark and troubling issues to discuss with students. Some
schools and school districts have prescribed programs on Internet Safety. Other
schools rely on classroom teachers to address this issue. Still others provide
parent education that helps spread the word on such dangers, though the success
of such efforts depends on parent attendance at these presentations.

There are also many free on line sites that have information on Internet
Safety. Here are a few:

http://www.isafe.org/

http://www .stavsafeonline.org/index.html

http://www.cvbersafety.ca.gov/

http://www.pbs.org/wegbh/pages/frontline/kidsonline/

Many of these sites, such as I-Safe, offer video clips that illustrate dangers
on the Internet. Please view these videos yourself first to determine if the content
and comprehension level of the content is appropriate for your students.

In addition to personal safety issues, these sites also discuss other important
topics such as copyright infringement (including illegal music and movie
downloads) and plagiarism. Students should understand that using copyrighted

materials without permission is illegal, and the punishments are real (including

88



large fines and possible prison time). It is important for students to know that
performing a copy/paste of biographical or other information from a reference
web site without proper citation in a school assignment is plagiarism. The

penalties for that include a grade of “F”, an

incomplete, or further sanctions by the school. e ou Expected Poctry?

Elementary school is the time to learn, or we may

THE Web site for an outfit called Term Paper Relief features a picture
of a young college student chewing her lip.

end up sending students to college with the . “Dama ittecomictp allon

says. “I'll have to cancel my Saturday
. night date to finish my term paper
" before the Monday deadline.”

mindset that this type of behavior is permissible.

Well, no, she won’t — not if she’s
enterprising enough to enlist Term
Paper Relief to write it for her. For $9.
obtain an “A-grade” paper that is fashi
“completely non-plagiarized.” This last
http://www .nytimes.com/2006/09/10/weekinreview | ... Mhanks to search engines ke Googe o
ave become adept at spotting those sh
downloadable papers that circulate fr

See image and this web link:

‘Term Paper Fro

[10mcgrath.html

One more aspect of this brief conversation should include the reliability of
the information students find on the web, and of the reputation of the site’s
publishers. Most web sites that contain offensive content, such as racist, sexist, or
hate group content will be blocked within the school district’s campuses. There

will be exceptions, however, as new sites that have

not yet been discovered by filters come on line
nearly every day. Many sites camouflage
themselves to draw impressionable children in.
See images and this web link at this hate site

frighteningly entitled, “Martin Luther King Jr.— A

True Historical Examination” :

http://martinlutherking .org/

Students would not be able to see this site if they typed “Martin Luther
King” into a Google search. But if students attempted to perform such a search
from a home computer with no filtering employed, they would likely find it and

might believe some of the words on the site to be true. We, as teachers, have to
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help students understand that just because something is on the Internet, doesn’t
mean that it is true. There are likely thousands of sites like this on line. Knowing
this helps us understand why filtering is necessary in school, and also understand
why it is important to teach students to be aware consumers of content on the

Internet.

90



Grade 4 - Lessons 8 & 9
Creates a webpage or other multimedia project with research acquired
through the Internet and other sources (books, interview); Creates a
research bibliography of books and websites with clickable links in
Word or PowerPoint
These lessons will take several visits to the computer lab to complete. If
portable storage is available, having students begin creating the presentations in
the lab, and resuming them in the classroom over a period of a week or two works
well for many students.
For more help with using PowerPoint, try the lessons posted at this address:

http://www .pumaland .net/Staff Pages/Henry Anker/Lesson Plans.html

You can also search the web for additional tutorials just by typing “Powerpoint
Lessons (or tutorials)” .

Every year that goes by means that less work done by students is done using
traditional paper and pencil, and more is done using computer technology. The
computer will soon become a tool equal to the pencil in schools, and then surpass
it. This is especially true of student projects.

Students by this age likely will have had much experience as a consumer of
web content, but it is more important that students also become skilled at creating
it. If students can do this, they will be more informed consumers as well, as they
will understand what went into creating the sites they use.

The same goes for being consumers of presentations, slide shows and
movies. As in Science class, it’s one thing to observe a science experiment and

make judgments based on being a witness, but it’s quite another to perform the

experiment and make observations and adjustments along the way, and then reflect
back on the process.
1. In this example, students will create a PowerPoint presentation that

features events and biographies of leaders in the Civil Rights Movement.
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Students can work alone, or in small groups. Begin by showing films, or
clips of films to the class. Be sure that you have the approval of your site
administrator, and to review the media first, to ensure that the content is
age appropriate. Using film will help students be better prepared to read
on the topic, both with books, and using computers and the Internet.
Examples might include the following:

a. “From Montgomery to Memphis”

b. “Mississippi Burning”
“The History Channel Presents Voices of Civil Rights”
“The March on Washington & The Civil Rights Movement”
e. “The Great Debaters”

o o

f. “The Tuskegee Airmen”

g. Citizen King DVD ~ Martin Luther King
Many of these titles may be available in your school’s library, or your public
library. Remember that public library systems in the City and County of Los
Angeles (and many other urban areas) offer online access to their catalogs as
well as the ability to request an item that is not in your local library be
brought to your library at no charge.

You likely will not have time to show all these films in their entirety,
so cue up to key portions of the film to illustrate a point. This will help
students understand that their presentation also will be digest versions that
feature highlights and spotlights in a very long and complex time in history.
2. Provide guidance to reading materials, web sites, and CD encyclopedic

content students will use to do their research. As students do their
research, they will either write by hand, or type their notes into a WP
application, mail message, Google Docs, or an AlphaSmart™ . Again, be
certain students know that copying/pasting information verbatim is not

legal. And if they are going to use a direct quote, to be sure and cite it
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properly. If students are citing printed materials, here is a guide that you
and your students can use to ensure that the citations are listed properly:

. Once students have completed their research, they can search for images
that would go well with specific passages on slides. There should be an
obvious connection between the text and the image. If a student’s text
described the assassination of President Lincoln, a landscape of a Civil
War battlefield would not do well to illustrate the text. As part of a mini-
lesson, students should be taught how to create a folder on a computer,
server, or flash drive. They can even create sub-folders titled “People”,
“Events”, etc... to sort their photos. Some sites even have video clips
that students can save for later use.

. Once the photos are stored and the text is saved, students can begin
assembling their presentations. An outline should be provided to
students so that can ensure that they are including the right content, in the
right order. You may want to create a template and/or storyboard for
students to use to plan out their order.

. A model lesson you’ll want to provide is one on design sense. Elements
of design you’ll want to present to students include the following:

1. the “Z scan” — meaning that it is important for students to
understand that viewers typically visually scan across a slide from
upper left to lower right.

2. appropriate use of color — meaning good contrast of color, no
yellow or light blue text, no garish combinations like red and pink.

3. use of bounding boxes — meaning that text, or images with poor
color matching with neighboring items be bound by a bordering
line.

4. use of appropriate sized text — meaning that text can be read from

a distance, that it is spaced properly, and there is not too much text
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on one slide (a good rule of thumb is a maximum of 5 sentences or
bullet points).

5. use of negative space - meaning that slides are not cluttered, and
that there is good spacing between items and edges of the slide.

6. limit use of transition and animation effects — remember these
two axioms: “less is more” and “‘just because you can do
something, doesn’t mean that you should so it”. Students often are
so excited about using these features that they overuse flipping,
flying, spinning effects to the distraction of their audience. It’s
okay for students to use these features sparingly.

. Model for students the process of copying and pasting the notes they

wrote into the slides. Model for students the process for importing,

copying/pasting, or using the drag & drop procedure for adding images to
slides.

. Model for students the creation of bounding boxes, color fills, moving

things around on the screen to respect the Z-scan attention of the

audience, and preserve negative space. Note: If you want to move an
object on the screen precisely, select the object(s), hold down the option
key, and tap the arrow key in the direction you want the object to go.

. After students have worked for a few minutes, or have finished their first

slide, remind students to save their file, and walk them through the

procedure, if necessary. Remind students to save their work after each
slide is completed.

. Allow students to work independently, or with their partners, as

applicable. Use proximity to notice good things that students are doing

and provide them positive reinforcement for their creativity and effort.

When you notice problems, rather than fixing them for students, find a

nurturing way to present them using the projector, and ask students for
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suggestion for ways to fix them.
6. Build rigor in the sophistication of the presentations as students show you

that they are ready.

95



Grade 4 - Lesson 10
Creates acrostic poem with formatted title and initial caps
Use the lesson, Creating an Acrostic Poem to not only accomplish many of the
goals here, but also to allow your students to better acquaint yourself with them.
This lesson can also be found at the following web address:

http://www.pumaland.net/Staff Pages/Henry Anker/Lesson Plans.html

(This lesson may require more than one visit to the computer lab to complete.)
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Lesson 11

Types 15-25 wpm with 85% + accuracy

The most effective way for students to become proficient in their
keyboarding at this level is with frequent opportunities to word process their
writing. Additionally, students can use a number of web sites or published
software your school may have to practice. Some schools also have
AlphaSmarts™ (inexpensive keyboards designed for text entry and transfer).
These devices, while excellent for word processing, also have lightweight
keyboarding practice exercises that help students progress from the Home Row
through the use of all keys, symbols, punctuation, numbers, and capital letters,
and provide words per minute counts with accuracy.

Any type of positive reinforcement/recognition of growth in keyboarding
helps motivate students to persevere. Communication with parents about the
importance of developing keyboarding skills can really help. This is akin to
practicing a musical instrument for a school band for 20 minutes each night. This
is something that most parents can easily support, as nearly all homes have
computers. For those students who do not have access to a computer at home, the

public library is a good option.
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Lesson 12

Restarts computer and diagnoses basic problems

Technical problems inevitably arise when using computers. The frequency and

severity of these problems generally is related to the age of the computers. There are

both common hardware and software issues that can cause problems. The following

table illustrates problems that students can be taught to repair:

Hardware / Software Problem

Possible Reason / Solution

Computer won'’t start up

Not plugged in at computer or outlet, plug

in, reset surge strip

Computer Freezes (stops working)

Software conflict, restart computer, or turn

computer off and then back on

Keyboard and/or mouse doesn’t respond

Check cables for one or both items, try

again, restart computer

Computer is on, but monitor does not

display anything

Turn on monitor, check monitor connection

to computer, check monitor power cord

Monitor is dim

Adjust monitor brightness with labeled
keyboard keys (or F15 on new iMacs), or
use Apple menu = System Preferences =

Displays

Volume is low or off

Adjust volume level with labeled volume

keys or dial on front of computer

Application has no window displayed

Application is open, though windows have
been closed, pull down File menu = New

Document

ALL CAPITAL LETTERS

Press caps lock key again to turn off

CD / DVD player does not read disk

Disk may be dirty, clean disk by using low

lint cloth gently, from inside to outer edge
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Teaching students to diagnose these problems, and in many cases, repair them, can
help a classroom teacher keep computers in use with minimal disruption. Training a
core group of students (not just boys, please!) in a classroom, or schoolwide, not only
improves computer use, but also builds self-esteem in these students. These students
will feel empowered, and should be encouraged to share what they know with other
students to further built capacity.

Training of these students can be done by each classroom teacher, or by a
technology coordinator who can develop a competent A/V crew that continually builds
their skills and recruits new students each year. Ideally, however, all students by 4"

grade will be able to resolve common computer problems.
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Lesson 13

Serves as peer tutor to others to mastery of specific skill

Many curricular programs have rubrics that show a student’s understanding
of material. Students demonstrate the highest level of understanding when they
can teach others what they know. Pairing students together allows students to
teach each other content, or the skills they used to produce a project.

Presenting a PowerPoint or Keynote presentation allows students to share
what they learned about a particular group of Native Americans, the life of a
President, the volcanoes situated around the Pacific Ocean, etc...

Students who know PowerPoint™ , Word™ , or the use of web browsers well
can be called upon to teach their peers those skills. Just like having student tech
support for problems that arise in the classroom is helpful, having students who
know how to perform a task in an application can alleviate a teacher from having
to attend to students as they are working. Students who are in need of help can be
taught how to quietly call upon their peers for help when needed.

Students who serve as peer tutors need to be taught teaching strategies as
well as the tools of a teacher: patience, modeling (not doing), questioning,
opportunities for practice and mastery are strategies peer tutors can use to help
their peers learn the skills they can perform.

You can facilitate opportunities for small groups of students to become
experts. You can train half of your class in a set of skills while the other half works
independently, and then switch groups, making each A group member responsible
for teaching their B group peers, and vise-versa.

You can train a group of students during recess, lunch, or other non-
instructional time. Then during class or lab time, those students would be
responsible for mentoring. You could also send students to work under the
direction of the Computer Lab Teacher, who could train your group of students to

be mentors, and then those students can serve as assistants in your classroom.
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One of the most effective ways for students to gain skills is to work during
off track time (in a year round school) under the direction of the Computer Lab
Teacher. When these students return from their off track time, they should be
capable of assisting both with technical and software issues, and might even be
able to share elements of lessons they assisted with (ideally, in your grade level)

while they were on ‘vacation’.
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